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Safety 
Regulatory Information: 
Caution: Only use approved and UL Listed accessories, battery 
packs and battery chargers. Do NOT attempt to charge 
damp/wet mobile computers or batteries. All components must 
be dry before connecting to an external power source. 
 
Power Supply 
Use only the approved power supply 50-14000-148 output rated 
5 Vdc and minimum 2 A. The power supply is certified to 
EN60950-1 with SELV outputs. Use of alternative power supply 
will invalidate any approval given to this device and may be 
dangerous. 
 
Warning for Use of Wireless Devices 
Please observe all warning notices with regard to the usage of 
wireless devices. 
 
Potentially Hazardous Atmospheres 
You are reminded of the need to observe restrictions on the use 
of radio devices in fuel depots, chemical plants etc. and areas 
where the air contains chemicals or particles (such as grain, dust, 
or metal powders) 
and any other area where you would normally be advised to turn 
off your vehicle engine. 
 
Safety in Aircraft 
Switch off your wireless device whenever you are instructed to 
do so by airport or airline staff. 
 
Pacemakers 
Pacemaker manufacturers recommended that a minimum of 
15cm (6 inches) be maintained between a handheld wireless 
device and a pacemaker to avoid potential interference with the 
pacemaker. These recommendations are consistent with 
independent research and recommendations by Wireless 
Technology Research. 
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Persons with Pacemakers: 
Persons with Pacemakers should ALWAYS keep the device 
more than 15cm (6 inches) from their pacemaker when turned 
ON and hence they should not carry the device in a breast 
pocket . 
Should use the ear furthest from the pacemaker to minimize the 
potential for interference. 
If you have any reason to suspect that interference is taking 
place, turn OFF your device. 
 
 
Hearing Aids 
The wireless device may interfere with some hearing aids. In the 
event of interference you may want to consult your hearing aid 
supplier to discuss solutions. 
 
Other Medical Devices 
Please consult your physician or the manufacturer of the medical 
device, to determine if the operation of your wireless product may 
interfere with the medical device. 
 
 
 

FCC / EU RF Exposure Guidelines 
Safety Information 
This device complies with internationally recognized standards 
covering Specific Absorption Rate (SAR) related to human 
exposure to electromagnetic fields from radio devices. 
 
Reducing RF Influence - Use Properly 
It is advisable to use the device only in the normal operating 
position. 
 
Handheld Devices 
This device was tested for typical body-worn operation. Use only 
tested and approved belt-holsters, hand strip and similar 
accessories to ensure FCC Compliance. The use of third-party 
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belt-clips, holsters, and similar accessories may not comply with 
FCC RF exposure compliance requirements, and should be 
avoided. 
To comply with FCC RF exposure requirements, this device must 
be operated in the hand with a minimum separation distance of 
2.5 cm or more from a person's body. Other operating 
configurations should be avoided. 
 
Radio Frequency Interference Requirements - FCC 
This device complies with Part 15 of the FCC Rules. Operation is 
subject to the following two conditions: (1) this device may not 
cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause 
undesired operation. 
 
 
 

 CE Marking and European 
Economic Area (EEA) 

The use of 2.4GHz RLAN's, for use through the EEA, have the 
following restrictions: 
l Maximum radiated transmit power of 100 mW EIRP in the 

frequency range 2.400 -2.4835 GHz 
l France, outside usage is restricted to 2.4 - 2.454 GHz. 
l Italy requires a user license for outside usage. 

 
Bluetooth® Wireless Technology for use through the EEA has 
the following restrictions: 
l Maximum radiated transmit power of 100mW EIRP in the 

frequency range 2.400 -2.4835 GHz 
l France, outside usage is restricted to 10mW EIRP 
l Italy requires a user license for outside usage. 
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Battery Information 
Our rechargeable battery packs are designed and constructed to 
the highest standards within the industry. 
However, there are limitations to how long a battery can operate 
or be stored before needing replacement. 
Many factors affect the actual life cycle of a battery pack, such as 
heat, cold, harsh environmental conditions and severe drops. 
When batteries are stored over six (6) months, some irreversible 
deterioration in overall battery quality may occur. Store batteries 
discharged in a dry, cool place, removed from the equipment to 
prevent loss of capacity, rusting of metallic parts and electrolyte 
leakage. When storing batteries for one year or longer, they 
should be charged and discharged at least once a year. If an 
electrolyte leakage is observed, avoid any contact with affected 
area and properly dispose of the battery. Batteries must be 
charged within the 32° to 95° F (0° to +35° C) ambient 
temperature range. 
Replace the battery when a significant loss of run time is 
detected. 

 
 
 

  Battery Caution 
Risk of explosion if battery is replaced by an incorrectly type.  
Dispose of used battery according to the local disposal 
instructions. 

 
 

 Waste Electrical and Electronic 
Equipment (WEEE)  

English: For EU Customers: All products at the end of their life 
must be returned to the reseller for recycling. 
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Notational Conventions 
The following conventions are used in this document: 
u Italics are used to highlight specific items in the general text, 

and to identify chapters and sections in this and related 
documents. 

u bullets (•) indicate: 
• action items 
• lists of alternatives 
• lists of required steps that are not necessarily sequential 
• Sequential lists (e.g., those that describe step-by-step 

procedures) appear as numbered lists. 
NOTE This symbol indicates something of special interest or 
importance to the reader. Failure to read the note will not result in 
physical harm to the reader, equipment or data. 
CAUTION This symbol indicates that if this information is ignored, 
the possibility of data or material damage may occur. 
WARNING! This symbol indicates that if this information is 
ignored the possibility that serious personal injury may occur. 
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1   Introduction 
This chapter lists the parts, accessories, hardware  
 

1-1 System Overview 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
System Overview table -1 

 Location Description 

1 LED Indicator Show the Status of Wi-Fi connection and battery. 

2 Power & 4 Programmable Keys Hold 5 seconds to power on/off the system. 

3 Speaker At rear side 

4 Hand Strap Screw Hole Mounted for hand strap 

5 Reset Hole For system reset to the default setting 

6 Battery locker Secure the Main Battery door 

7 Strap Holes Mount for neck strap and wrist strap. 

8 Charging Slot Charger Slot for recharging the battery. 

① 

② 

⑧ 
⑦ 

⑥ 

③ 

⑤ 

④ ④ 

⑦ ⑦ 
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1-2 Standard Components 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Items 

1 Mobile System 

2 
Travel Charger 

(Note: Only for power charge use, not for data transfer use) 

3 Main Battery  

4 Holster 

5 Power Adapter (AC-USB connector) 

6 Hand Strap 

7 Wrist Strap 

8 Neck Strap 
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3 

5 8 

1 6 7 4 
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1-3 Optional Accessory 

 

  

 
 Items 

1 Standard Battery Charger 

2 Power Brick of Standard Battery Charger 

3 
Power Cord of Standard Battery Charger  

Note: Power cord are various according to the shipping country. 

4 MSR Module 

5 2-in-1 MSR & Scanner Module 

6 USB Cable for synchronization & programming 

1 3 2 

4 6 5 
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1-4 Hardware Description 
 

Item Features Descriptions 
1 Main Processor l Marvell PXA270 416MHz (Xscale Core) 
2 System Memory l 128Mbytes SDRAM  

l Around 115MB use for system operation, otherwise 

for storing system loader and system data 
3 System Storage l 1Gbytes Flash (ROM file system) 

l More than 300MB for storing WindowCE image and 

OEM application programs 

l Around 600MB leaved for system and user storage, 

emulated as folders in all system directories 

l Around 100MB leaved for storing OEM data and 

configurations This device provides a specific 

mechanism to let system integrator easily to 

integrate the OEM applications and device 

configurations into device as factory default mode 

without merging OEM applications into WindowCE 

image It can help system integrator doesn’t have to 

maintain the device after end user crashed the 

device by reset device to factory default mode or 

on-line updated the OS image from internet 
4 Display l PXA270 Display controller 

l Share System Memory as Video Frame Buffer 

l Resolution : 272x480 pixels, 16 bit color 

l 4 way rotator for direction detection  
5 LCD l 43 inches TFT LCD – WQVGA (480x272 pixels 

resolution) 

l Transmissive display mode 

l Digital RGB 8bit color depth , 10 LEDs backlight 
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Item Features Descriptions 
6 Touch Panel l LCD panel with touch panel design 

l Resistor 80% Transparency (Film to Glass type) 
7 Audio l Stereo audio system with mono speaker design 

l 05W speaker amplifier 

l Headphone stereo output (Optional) 
8 Secure Digital 

Socket 
l SD memory card (Support up to: 2Gbytes) 

9 WiFi IEEE 

80211b/g 
l Auto fallback mode : 6M~54M(80211g), 

1M~11M(80211b) 

l Complying with Wireless Ethernet Compatibility 

Alliance 

l Support hardware signaling BT WiFi co-existence 

l Link LED indicator 

l Output Power : 

802.11b: +18 dBm (peak) / 16 dBm (e.i.r.p.) 

802.11g: +21 dBm (peak) / 16 dBm (e.i.r.p.) 
10 Bluetooth l Compliant with Bluetooth Specification V2.0+EDR 

l Output Power : -1dBm (peak) / 1dBm (e.i.r.p.) 

(Class 2) 

l Receive Sensitivity : Typical -78dBm 
11 USB Client l USB Specification - 11 compliant 

l Full-Speed operation on half-duplex at 12Mbps 

baud rate 
12 USB Host l Compliant with USB Specification 11 and OHCI 

Spec 

l Support both low-speed and full-speed USB 

devices 

l Expansion slot for optional device (either one of the 

MSR reader, IC card reader, Barcode scanner, and 

so on) 
13 FFUART port l Expansion slot for optional device (either one of the 

MSR reader, IC card reader, Barcode scanner, and 

so on) 

l Maximum baud rate 921600bps 

l Full function UART 
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14 Buttons l Keypad – 4 programmable buttons 
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Item Features Descriptions 
15 Power / Reset 

buttons 
l Power Button : Suspend/ Resume Device and 

“Enter” Key 

l Reset Button : Warm Reset  

l Press Power and Reset buttons simultaneously: 

Cold Reset 
16 LED indicators l Green: ON – device power on , OFF – device off / 

suspend 

l Blue: Link Status of WiFi manager 

l Red: Flash – Battery low, ON –Charging battery 
17 Vibrator l Vibrational indicator 
18 Smart Battery l 37V Li-lon battery pack : 2200mA/h 

l Charging time : maximum 35 ~ 4Hours 

l Thermal / Over Charging Protections 

l Auto mode of Low / High speed charging 

mechanism 
19 Travel Charger l Mini-USB type connector 
20 Adapter l AC110V ~ 240V / DC5V ( 10W ) 50~60Hz 
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1-5 System Feature Description 
 

Item Features Descriptions 

1  Application l File Explorer 
l Internet Explorer 6.0 for Windows CE 
l Windows Media Player 
l Windows CE standard shell (Windows 

XP-like skin) 
2  File System l ROM File system with hive registry 
3  Graphic / Display  l 480x272x16 (Landscape mode) as 

panel default mode 272x480x16 
(Portrait mode) as system default 
mode 

l Compliant with Graphics, Windowing 
and Event Subsystems of Window CE 
embedded. 

l Still Image Codec Support 
l DirectShow 
l Support screen rotation feature 

4  User Input 
Interface 

l Stylus input rather than mouse input 
capability 

l USB Keyboard / Mouse (optional) – 
USB Host Interface 

l Buttons: 4 programmable keys 
(without system wakeup feature) 

5  Audio l Audio playback feature only 
l Support waveform audio Input/Output 

device APIs 
l Configurable sound enable/disable 

feature of system event, message 
notification, screen taps. 

l MP3 Codec 
l MPEG-1 Layer 1 and 2 audio codec 
l Waveform audio renderer 
l WMA Codec 
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Item Features Descriptions 

6  Storage l Removable storage : SD memory (up 
to 2GB) : USB storage (optional) 

l Persistent storage: NAND flash 
memory (On Board) 

7  Data 
Communication 
WLAN 

l Support seamless roaming in 
IEEE802.11b/g WLAN authentication 
infrastructure 

l Support single SSID 
l Support fast Wi-Fi roaming 
l Support always on Wi-Fi 
l WPA and 802.11i security standard 

(AES/CCMP and WEP with TKIP 
security mechanism) 

l Support Window Wireless Zero 
Configuration service 

8  Data 
Communication 
Bluetooth 

l Compliant Bluetooth software 
specification 

l Window CE Bluetooth communication 
software stack 

l “SPP” “FTP” “Activesync” profile 
supports 

l Support Winsock Bluetooth 
programming interface  

9  Data 
Synchronization 

l Bluetooth Window CE Active-sync 
l USB SD card reader 

10  Vibration 
Notification 

l Support Programming API of Window 
CE device manager 

11  System Power 
State 

l Support Remote Application Interface 
(RAPI) for retrieves the power state of 
system 
: Battery Status / AC status 

12  Backlight l Support Programming API of Window 
CE device manager 

l Support 10 backlight scales 
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Item Features Descriptions 

13  Network Features l NDIS network driver architecture 
l TCP/IP 
l Windows Networking API /Redirector 

[SMB] 
l WinSock Support 

14  Security  l Authentication Services (SSPI) 
l Credential Manager 
l CrytoAPI 1.0 

15  Applications and 
Service 
Development 

l .NET compact framework 2.0 
l Active Template Library (ATL) 
l C Libraries and Runtimes 
l COM and DCOM 
l Microsoft Foundation Classes (MFC) 
l Object Exahange Protocol 
l Standard SDK for Windows CE 
l MSXML 3.0 

16  Fonts l Courier New (Subset 1_30) 
l Tahoma (Subset 1_07) 
l Wingding 

17  Multilingual l English (English software Input Panel) 
l Traditional Chinese 
l (Bopomofo/ Chan Jei software Input 

Panel, Handwriting) 
l Simplified Chinese (Shuang Pin 

software Input Panel) 
18  OEM l Factory Device Manager 

l User mode / Admin mode operation 
modes 
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2   Getting Started 
 

2-1 Installing the Main Battery  
 

  

1. Rotate the lock screw counter-clockwise with a flat-head screw driver 
or a coin to release the lock.  

2. Slide the battery door outwards as direction of the arrow and open the 
battery door. 

 

 
3. Push down the main battery into the battery bay until you hear a clip 

sound. 

4. Put back the battery door and fasten the lock screw in clockwise way. 

 
 
 

Battery  

Door 

Battery Bay Main 

Battery 
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2-2 Removing the Main Battery 
 

  
1. Open the battery door described in Chapter 2-1 first. 

2. Please use your finger nail to pull the fillister on the battery latch (the 
circle marked) toward the front as the direction of the arrow shows. 

3. Flip up and remove the battery to replace another. 
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2-3 Installing / Uninstalling SD Card 
SD Card Slot locates in the inner side of the battery bay which is a push-push 
type. 
 

2-3-1 Installing the SD Card  

   
1. To open the battery door and remove the main battery first as 

described in Chapter 2-1 and 2-2. 

2. To push the SD card into the Slot until it clicks. 

3. To remove the SD Card, please push again the SD card and slide 
outwards. 

 
 
 

2-3-2 Uninstalling the SD Card 
 

 
1. To remove the SD Card, please push again the SD card and slide 

outwards. 
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2-4 Neck Strap Installation 
 
To installing the Neck Strap, please unthread the Neck Strap first then follow 
the below steps. 
 
 

    
1. Start threading the Neck Strap through the Strap Hole as arrow 

direction. 

2. Thread through the plastic ring to make it secured with the Neck 
strap. 

3. Repeat a and b at the other side. 

 
 

 

 
4. Finished. 
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2-5 Wrist Strap Installation 
 

    
1. Start threading the Wrist Strap through the Strap Ring.  

2. Thread through as the arrow direction point. 

 
 

 
3. Finished. 
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2-6 Hand Strap Installation 
 

 

1. Start threading the Hand Strap through the strap hole at the either 
side of the system.  

2. Thread through as the arrows direction show. 

 

 

    

3. Finish the Hand Strap threading through the strap hole at the side of 
the system. 

 

 

 

 

 

 

Hand strap screw holes 
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4. Fasten the Hand Strap Plastic Ring with the screws (2) to the screw 
holes at rear side of the system. 

5. Thread the Hand Strap through the plastic ring as the direction of the 
arrows show. 

 

 

 
6. Finished. 
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2-7 Charging the Main Battery 

 
 

1. Connect the Mobile System, Travel Charger and USB-AC power 
Adaptor as above arrow instruction. 

2. Plug the USB-AC Adapter to the electrical outlet. 

3. The LED light turns Orange while recharging. 

4. When recharging is complete, the LED light turns Green. 

 

 
Ø Note: Please make sure to align the juts (2) of the Travel 

Charger into the holes at the bottom of the Mobile system when 
connecting the 2 units. 
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2-8 Backup Battery 
The internal Backup Battery can last for 5 minutes. The screen will be 
powered on with the last status when you replaced the Main Battery within 5 
minutes. 

 

When the Main Battery is out of system over 5 minutes, the boot-up screen 
will pop up as above figure shows after pressing the Power Button for 1 
second. 
 

Ø Note: Normal procedure of system power-on is holding down 
the Power Button for 5 seconds. 
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2-9 Power on/off the System 

 
 
Turn on the System 
Press and hold the Power Button (as the arrow marked) for 5 seconds to turn 
on the system. 
 
Turn off the System 
To press the Power Button for 5 seconds or press “Start Menu” > “Suspend” 
to turn off the system. 

 

Power Button 
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3   Using the System 
 

3-1 Wi-Fi Connection Settings 
3-1-1 Connecting to an Existing Network 
 
Enable Wireless Connection 

        
1. Enable the Wireless Connection by choosing as steps of “Start” > 

“Settings” > “Control Panel” > “Network and Dial-up Connections”. 

2. Right click on the “GPS186861” and tap the “Enable” icon in the drop 
down menu to access the wireless connection. 

3. After enable the “GPSI86861”, you will see the icon    appears in 
the system tray. 
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Select a Network and get connection 

    
4. You will see the “GPSI86861” window pop up after you double click on 

the icon    .  

5. Press “Main” tab and “Configure” button. 

6. Select the network you want and put the key (password) if needed, 
then press “Connect” button to get connection.  

Ø NOTE: You can create a new network by selecting “Add New…” 
(please see Chapter 3-1-2 ) 

 
7. After WiFi is successfully connected, the screen will pop up a 

message showing the status of the connecting condition and the icon     
in he system tray will turn to icon   . 
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3-1-2 Adding a New Network 
To add a new network connection, please enable the wireless connection first 
by following the steps in Chapter 3-1-1. 
 

 
1. The “Wireless Properties” dialog box pop up after pressing “Add 

New…”.   

2. To put a network name you want in “Network name (SSID)” text box, 
select “Encryption” and “Authentication” and enter password in the 
“Network key” to access a new network point existing in you place.  

3. Wireless successfully connected when Status showing “Connected to 
xxx”. 

 
 



 24 

3-1-3 Enhancing the WiFi Connection 
If the status of WiFi Connection stays low, please follow the below steps:  
 

       

1. Please double-click on the icon    in the system tray. The 
“GSP186861” dialog will appear. 

2. Please select “Advance” tab and move the “Power Management” to 
the “Best Performance level” and the “Roaming Feature” to the far 
right. 

3. Press “OK” to save the settings. 
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3-1-4 SSID Lock Function 

      
 

1. Enable Wireless Connection by following the steps in Chapter 3-1-1. 

2. After enable the Wireless Connection, the icon     will appear in the 
system tray. Double click the icon    and press “configure” button on 
the “GPSI86861” window. “Windows Information” window will appear. 

3. Select a network you want and click the “Lock to specific SSID” check 
box. Click “Connect” button to lock the SSID. 

4. SSID is locked successfully by showing “Status” as” Connected to.…” 
on the “Wireless Information” window. 
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3-2 Connecting to a Bluetooth Device 
3-2-1 Turning on the Bluetooth Connection 
 

        
1. Enable the Bluetooth Connection by following the steps “Start” > 

“Settings” > “Control Panel” > “Bluetooth Device”. 

2. Select “Config” tab In the “Bluetooth Manager “ dialog box. 

3. Press “Turn Bluetooth ON” button to “Turn Bluetooth Off” to enable 
the Bluetooth connection. 
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3-2-2 Scanning Bluetooth Devices 
We can scan the devices in a area and active their services in a “Bluetooth 
Manger” dialog by selecting “Start” > “Settings” > “Control Panel” > “Bluetooth 
Device”.  
 

 
1. To turn on the Bluetooth Connection. (Chapter 3-2-1) 

2. Select “Scan Device” tab in the “Bluetooth Manager dialog box”. 

3. Press “Scan Device” button to scan the surrounding Bluetooth 
devices. 

4. Select a Bluetooth device you want listing in the “Device menu” and 
press “Add Device” button. 

Ø Note: Please refer to the Chapter 4-1-10 for Programming 
Interface of Bluetooth. 
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3-2-3 Connecting to a Bluetooth Printer 
Please perform the steps in the Chapter 3-2-1 to turn the Bluetooth on and 
the Chapter 3-2-2 to scan the surrounding Bluetooth device first. 

 
 
Paring a Bluetooth Printer Device 

In Bluetooth, you have the option to "pair" two devices. When you pair with a 
Bluetooth device, this device will be "remembered” that means you need not 
search for the device again when you want to use the device next time.  

 

     
1. Select a Bluetooth printer device you want on the Device list after 

tapping on the “Scan Devices” button. 

2. Press “Add Device” button. A “Bluetooth Manager” dialog box will pop 
up.  

3. Press “Yes” button to authenticate (pair) the mobile system and the 
printer device.  

4. A PIN code is request when paring to a printer device. 

5. Enter the pin code to complete the authentication. 
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Active Printer Service 
 

    
1. Tapping on the Bluetooth Printer device you want and choose a 

service on the “Service” menu. The current example is selecting 
“Printer” service. 

2. Press “Active Service” button to active the Printer service. A “Serial 
Port Setting” dialog box will appear. 

3. Choose the COM port options in the drop down list you want.  

4. Press “OK”. 
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3-2-4 To Synchronize with a PC via Bluetooth 
Before Synchronize the Mobile System with a PC, please turn on the 
Bluetooth connection as described in the Chapter 3-2-1 and pair the PC and 
the Mobile System first as detailed in the below. 
 
 
 

Pairing a Bluetooth enabled PC 
When you pair with a Bluetooth device, this device will be "remembered” that 
means you need not search for the device again when you want to use the 
device next time.  
 

       
1. To turn on the Bluetooth Connection first, see Chapter 3-2-1. 

2. Select a Bluetooth enabled PC device you want in the “Device” list.  

3. Press “Add Device” button. A “Bluetooth Manager” dialog box will pop 
up. 

4. Press “Yes” button to authenticate the Mobile System and the PC. 
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5. A PIN Entry request will pop up on the 2 Bluetooth connecting devices 

for paring.  

Ø Note: Here is an example screen captured from the IVT 
Bluetooth dongle and the pertaining AP installed on the PC. 

 
6. Enter the same pin code on both sides. 

 

    
7. Select service at “Service” menu you want. Here we choose “ASYNC” 

service.  

8. Press “Active Service” button. 
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Installing the Microsoft ActiveSync 
To synchronize the Mobile System with a PC, we need to install the Microsoft 
ActiveSync Program on the PC. Please refer the detail installation procedures 
to the Microsoft official website. 
 
 

 
Check the Assigned Bluetooth Serial Com Port 

Check to see what the Bluetooth serial port is assigned. The COM port is 
assigned according to the Bluetooth Device you use. It is only checked for the 
first time. 
 
The following Bluetooth Settings window is captured by IVT Bluetooth dongle 
and the pertaining AP. The screen various according to the AP you install. 
 

 
1. Open the Bluetooth AP and check the COM Port that is assigned. 

2. Select the “View” > “Service” menu on the toolbar of IVT AP. We will 
see the assigned Serial Port. In this case, it is mapped to COM7 or 
COM8. We will need the assigned COM Port to set up for the 
Microsoft ActiveSync Program. The setting only happens in the first 
time. 
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Setup COM Port in the ActiveSync Program 
The COM port is only setup for the first time. 
 

      
1. Open the Microsoft ActiveSync Program on your PC. 

2. Choose “File” > “Connection Settings” menu on the toolbar. A 
“Connections Settings” dialog box will appear. 

3. Enable the “Allow connections to one of the following” check box and 
select the COM Port options. In this case we choose COM 7. 

4. Press “OK” button to save the connection settings. 

 
 
 

Connecting the Mobile System to the Bluetooth enabled PC 
 

      
1. Click “Start” > “Run” to run ”repllog” in the text box.  

2. Press “OK” button. A “Bluetooth Status” dialog box will pop up. Press 
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“Hide” to hide the message. 

3. After running the “repllog”, the Mobile System connects to the PC 
automatically and a “New Partnership” is requested to set up for the 
first time. 

 
 

 
4. Press “Next” button. 

 

 

 

 

 
5. A “Select Synchronization Settings” window will appear.  

6. Press “Setting” for your own setting inquiry. 

7. Press “Next” button to the “Setup Complete Window”. 
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8. To press “Finish” button to complete the setup procedure. 

 
 
 

Disconnecting the PC 
 

 
1. Go to “Start” > “Settings” > “Control Panel” > “Bluetooth Device” on 

the Mobile System. 

2. Press “Deactive Service” button to disable the service and disconnect 
the PC. 
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3-2-5 Bluetooth File Transfer (FTP) 
To transfer files from a PC to the Mobile System, please turn on the Bluetooth 
connection and scanning the Bluetooth enabled PC 
In this case, we use IVT Bluetooth Dongle and the pertaining AP as an 
example. The screen various according to the AP you install. 
 

 

   
1. Enabling the Bluetooth connection, see the Chapter 3-2-1. 

2. Scanning the destination PC, see the Chapter 3-2-2. 

3. Press “Bluetooth File Transfer Service” on the IVT Bluetooth AP. A 
“Remote Shared Folder” window will appear. 

4. Put files on it by performing copy-and-past. 

 
 

 
5. Right Click on the file and press “Execute” to transfer the file to your 

system. 
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Access the files on the Mobile System 

   

1. To Select “My Device” icon on Today Screen. 

2. Click “View” > “Options” on the toolbar. 

3. To disable the 3 check boxes on the “Folder Options” dialog box. 

4. You will see the “Temp” folder appears on the “My Device” Window. 

 

 
5. If the files transferring is successful. It will create a “FTP” folder in the 

Temp Folder automatically. All the transferring files are put in the 
folder. 
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3-3 Backup and Restoring the System 
 

 
Go to “Start” > “Control Panel” > “Device Config”. 

 
 
 

3-3-1 45BBackup the System 
To restore the system, please follow Chapter 3-3 then the below steps.  
 

     
1. Select “Backup” tab then enable the “Entire the registry on your 

device” and the “All your files on your device” check boxes. 
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2. Press “Browse” button if you want to specify the location Backup Files 
to be saved to. 

3. Press “Backup” button to start backup the system. 

 
 
 

3-3-2 Restoring the System 
To restore the system, please follow Chapter 3-3 then the below steps.  
 

     
1. Press “Restore”. 

2. Press “OK” of “RESET NOW” dialog to finish the Restore. 

Ø Note: System Restore means to restore the system to the latest 
“Backup” version.  
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3-4 Switching the Admin / User mode 
 

     
1. Please follow below steps to access the Mode Change screen. 

“Start Menu” > “Settings“ > “Control Panel“ > “Password“ > Enter 
Password (default is 1111) 

2. The “Password Properties” dialog will popup after entering the 
password (default), select the Mode you want. Press “OK” to save the 
setting. 

3. If the mode being switched, the “Mode Changed” dialog will popup. 
Press “OK” to restart the system. 
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3-5 Power Management Settings 
3-5-1 CPU Power Mode Settings 
 

      
1. Select “Start” > ” Control Panel”  > ” FPM” button 

2. Select the mode you want on the “FPM” window. 

Ø Note: The CPU Power Consumption is ranked as: 
” Performance Mode” > ” Dynamic Power Management” > ” 
Power Saving Mode”. 
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3-5-2 System Configuring Power Mode Settings 

     
1. Click “Start” > ” Control Panel” > ” Power” button 

2. Select “Schemes” tab. 

3. Set up the power mode as “Battery Power” or “AC Power” in the 
“Power Scheme” drop down menu. 

4. To set up the times you want on each option for turning the Mobile 
System off or going to standby mode after a period of inactivity.  
a. Switch state to User Idle. 
b. Switch state to System Idle. 
c. Switch state to suspend. 

5. Press “OK” to save the settings. 
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3-5-3 Display Backlight Settings 
 

    
1. Go to “Start” > “Control Panel”. 

2. Double click on the “Display” icon. 

3. In the “Display Properties” window, select “Backlight” tab. 

4. You can enable the backlight savings by checking and setting turn-off 
time in the checkboxes of “Battery power…”, “External power…” and 
“Enable Dim Mode…”  

5. To drag the “Bright Level” slider on “MIN – MAX” scale for “Battery 
Power” and “External (AC) power”. 

6. Press ”OK” button to save the settings. 

 
Ø Note: If you enable the “Dim Mode”, the system runs “Dim 

Mode” prior to “Battery power” and “External power”. 
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3-5-4 WiFi Power Mode Settings 
 

      
1. To tap “Start” > ”Control Panel” > ”Network and Dial-up Connections” 

button. 

2. Hold to press “GSPI86861” button until the drop down menu appears. 

3. Press “Enable” in the drop down menu to active the WiFi Connection. 

4. After step “c”, the “GSPI86861” setup window as above right figure 
will pop up. 

5. To tap the “Advance” tab. 

6. To set up the “Power Management” by dragging the slider on the 
“Best Performance – Best Battery” scale. 

 
Ø Note: To conserve more battery power, drag the slider toward 

the “Best Battery” which also reduces the WiFi signal 
performance.  
To improve signal performance, drag the slider toward the “Best 
Performance” which also consumes more power and shorten 
the battery life.  
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3-6 LED Indicator Description 
The LED indicator is located in the front of the Mobile System which indicates 
the status of Power on/off, the Main Battery and WiFi Link. The Description as 
follows:                                                                                                                                                

 

 

Green color LED:  

Battery power charging state(S/W) 

 

LED ON: Battery power charging finished (100%) 

   

 

 

Orange color LED:  

Battery power charging state(S/W) 

 

LED ON: Battery power charging 

   

 

Blue color LED: 

Link status of WiFi manager (H/W) 

 

LED ON: WiFi link active 

   

 

 
Red color LED:  

Battery power state(S/W) 

 

LED Flash: Battery low 

LED ON: Critical battery low 
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3-7 Resetting the Mobile System 
The mobile system provides functions of “Reset to the factory default settings” 
and “cold boot”. The detail procedures as bellows:  

3-7-1 Reset to the Factory Default Settings 

    

1. Use a tool to gently press the “Reset Hole” on the rear of the Mobile 
System while keep holding down the “Power Button” throughout until 
the system vibration occurs. 

2. Release the “Reset Hole” and press the “Power Button” the second 
time after the system vibration occurs.  

3. The calibration instruction window will pop up to lead you to the 
“Reset to the factory default settings”. 

     
4. Completing the “Calibration window” instructions. 

5. Press “Yes” to accept the “reset”. 

6. Click “Yes” to confirm again. 

7. System rest window appears as above far right picture. 
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3-7-2 Cold Boot 

    

1. Use a tool to gently press the “Reset Hole” on the rear of the Mobile 
System while keep holding the “Power Button” throughout. 

2. Release the press of “Reset Hole” and the “Power Button” at the 
same time after system vibration occurs. 

 

   
3. System reboot to Today Screen as above picture shows. 

Ø Note: Today Screen slightly varies according to the OS version 
installed. 
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4   Application Programming Interface  
4-1 Windows Embedded CE 5.0 Standard 
 
21BInterface Introduction 

Most of software programming interfaces of each device are following 
WindowCE standard architecture to be designed. 

- Core OS Service 
(Uhttp://msdn.microsoft.com/en-us/library/aa450512.aspxU)  

- Kernel 
(HUhttp://msdn.microsoft.com/en-us/library/aa450998.aspxUH) 
 

 
22BProgramming interface of RAM file system  

- File system and storage management  
(HUhttp://msdn.microsoft.com/en-us/library/ms892386.aspxUH) 

 
 

23BProgramming interface of Persistent storage 
- Folder name: “Backup” 
- Block Drivers  

( H Uhttp://msdn.microsoft.com/en-us/library/ms923712.aspxU H ) 
- File system and storage management  

( HUhttp://msdn.microsoft.com/en-us/library/ms892386.aspxUH ) 
 
 

Programming interface of Secure Digital Card 
- Folder name: “Storage Card” 
- Secure Digital Card Drivers  

( HUhttp://msdn.microsoft.com/en-us/library/ms923739.aspxUH ) 
- Block Drivers  

( HUhttp://msdn.microsoft.com/en-us/library/ms923712.aspxUH ) 
- File system and storage management  

( HUhttp://msdn.microsoft.com/en-us/library/ms892386.aspx UH ) 
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25BProgramming interface of Audio 
- Audio  

( HUhttp://msdn.microsoft.com/en-us/library/ms890653.aspxUH ) 
- Audio Drivers 

( HUhttp://msdn.microsoft.com/en-us/library/aa910103.aspxUH ) 
 
 

26BProgramming interface of Display(LCD) 
- Shell and User Interface  

( HUhttp://msdn.microsoft.com/en-us/library/aa453940.aspxUH ) 
- Graphic  

( HUhttp://msdn.microsoft.com/en-us/library/ms923392.aspxUH ) 
- Display Drivers 

( HUhttp://msdn.microsoft.com/en-us/library/aa447505.aspxUH ) 
 
 

27BProgramming interface of USB Host 
- USB Host Drivers  

( HUhttp://msdn.microsoft.com/en-us/library/ms923751.aspxUH ) 
- Shell, GWES, and User Interface  

( HUhttp://msdn.microsoft.com/en-us/library/aa932172.aspxUH ) 
 
 

28BProgramming interface of MSR Reader 
 
 

29BProgramming interface of USB Slave 
- USB Function Drivers  

( HUhttp://msdn.microsoft.com/en-us/library/aa931533.aspxUH ) 
- USB Serial Host Driver  (Activesync) 

( HUhttp://msdn.microsoft.com/en-us/library/aa932783.aspxUH ) 
- File system and storage management (Card Reader) 

( HUhttp://msdn.microsoft.com/en-us/library/aa914412.aspxUH ) 
 

B 

 
Programming interface of Bluetooth 

- Bluetooth HCI Transport Driver  
( HUhttp://msdn.microsoft.com/en-us/library/aa924569.aspxUH ) 

- Networking - Core 
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( HUhttp://msdn.microsoft.com/en-us/library/aa917156.aspxUH ) 
- Networking - Remote 

( HUhttp://msdn.microsoft.com/en-us/library/aa920180.aspxUH ) 
- Networking – Wireless (Bluetooth) 

( HUhttp://msdn.microsoft.com/en-us/library/aa917877.aspxUH ) 
 
 

31BProgramming interface of Wireless 
- Network Driver  

( HUhttp://msdn.microsoft.com/en-us/library/aa919639.aspxUH ) 
- Networking - Core 

( HUhttp://msdn.microsoft.com/en-us/library/aa917156.aspxUH ) 
- Networking - Remote 

( HUhttp://msdn.microsoft.com/en-us/library/aa920180.aspxUH ) 
- Networking – Wireless (Wi-Fi) 

( HUhttp://msdn.microsoft.com/en-us/library/aa916578.aspxUH ) 
 
 

32BProgramming interface of Touch 
- Touch Screen Drivers  

( HUhttp://msdn.microsoft.com/en-us/library/aa925927.aspxUH ) 
- Shell, GWES, and User Interface  

( HUhttp://msdn.microsoft.com/en-us/library/aa932172.aspxUH ) 
 
 

33BProgramming interface of Button 
- Keyboard Drivers  

( HUhttp://msdn.microsoft.com/en-us/library/aa932012.aspxUH ) 
- Shell, GWES, and User Interface  

( HUhttp://msdn.microsoft.com/en-us/library/aa932172.aspxUH ) 
 
 

34BProgramming interface of Vibrator 
- Notification LED Drivers  

( HUhttp://msdn.microsoft.com/en-us/library/aa925927.aspxUH ) 
- Shell, GWES, and User Interface  

( HUhttp://msdn.microsoft.com/en-us/library/aa932172.aspxUH ) 
 

35B 
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Programming interface of System Power 
- Battery Drivers (Battery) 

( HUhttp://msdn.microsoft.com/en-us/library/aa932396.aspxUH ) 
- Power Management (Power status – battery/DC) 

( HUhttp://msdn.microsoft.com/en-us/library/aa923906.aspxUH ) 
 
 

Programming interface of Power Management 
- Power Management  

( HUhttp://msdn.microsoft.com/en-us/library/aa923906.aspxUH ) 
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4-2 Non WindowsCE Standard 
4-2-1 Admin/User Mode Application  
 
Architecture Introduction: 

System provides three pair of directories to map the working folder of each 
operating mode. 
 
Working folders name of Admin mode 
/Windows/Desktop   
File folder for saving the shortcut of application program in the Desktop. 
/Windows/Programs   
File folder for saving the shortcut of application program in the Programs tab 
at start menu. 
/Windows/StartUp  
File folder for saving the shortcut of application program in the StartUp folder 
where to be used to auto-run the programs during OS booting phase . 

 
Working folders name of User mode 
/Windows/Desktop_   
File folder for saving the shortcut of application program in the Desktop. 
/Windows/Programs_   
File folder for saving the shortcut of application program in the Programs tab 
at start menu. 
/Windows/StartUp_  
File folder for saving the shortcut of application program in the StartUp folder 
where to be used to auto-run the programs during OS booting phase. 
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Switching between Admin mode and User mode 
There is a control box in control panel applet, named - “Password”, The 
Manufacturer redefine the password policy of WindowCE standard. The 
password control box should input the password in advance to enter the page 
for finding the selection items of changing the operating mode and/or reset 
the default password. The default password is “1111”. 
Step: 

1. Find Password control box from control panel applet. 
2. Enter password: “1111” (Default) 
3. Select User mode or Admin mode. 
4. Type the “OK” button of password properties control box. 
5. Type the “OK” button of “Mode Chang” dialog for double confirmation. 
6. System would reboot automatically to the selected mode. 

 
 
How to use this feature? 

System Integrator only has to copy the desired files to the working folders of 
each mode. 
It is impossible to change the operation mode by reset system to factory 
default.  
In case user forgets the password. The only way to achieve the password is 
to run the Manufacturer maintenance application by copying the application to 
SD card and cold reset the device. 
Step: 

1. Copy the desired files to the working folder of the operation mode 
2. Follow Section “Switch the operation mode between Admin mode and 

User mode” to switch operation mode. 



 54 

4-2-2 Overwrite Factory Default  
 
Architecture Introduction: 

The Manufacturer provides a mechanism to merge the OEM application and 
OEM specific settings into WindowCE operating system during booting phase. 
This feature can make OEM stuffs as system default components. There are 
many benefits for device maintenance.  
It is a valuable feature for OEM doesn’t have to reinstall OEM programs after 
end user reset the device to factory default mode. This benefit also helps to 
reduce the RMA cost from OEM vender. 
Because of this system architecture, WindowCE operating system and OEM 
application programs are not merged together. So both parts can be 
upgraded separately. 
 

Architecture of the OEM Device Manager 
System Integrator should base on the directory structure of WindowCE to 
prepare the OEM installation files in SD card. All files in “GHARST” file 
directory would be copy into WindowCE file system during cold booting phase. 
By the way, the config files in “configfiles” directory are for system registry 
maintenance.  
 

 
 

GHARST 

Configfiles 
Oem.cfg 

System.cfg 

Windows 

Program Files 

My Documents 

Documents and Settings 

Temp 
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Merge an application program into default operating system by 
using the OEM Device Manager 

 
u Example: 

 
- For Auto-running the OEM application at booting phase of user mode 

when after reset to factory default. 
 

1. Create a file directory “GHARST” in root folder of SD card. 
2. Change into “GHART” folder to create directory “Windows”.  
3. Change into “Windows” folder to create directory “StartUp_”. 
4. Copy the OEM application file into “Windows->StartUp_” folder. 

[Second way is: copy OEM application file into “Windows” folder, creates a 
lnk file of OEM application and copy it into “Windows->StartUp_” folder. 

5. Put SD card into the SD socket on B21 device. 
6. Use OEM Device Manager to merge all files in “GHARST” folder in SD 

card into device. After the file integration process, all OEM specify files will 
be the system default components of B21 device. 

 
- Place the OEM application at “Programs” folder in Windows Start 

menu - System running in user mode.   
1. Create a file directory “GHARST” in root folder of SD card. 
2. Change into “GHART” folder to create directory “Windows”.  
3. Change into “Windows” folder to create directory “Programs_”. 
4. Copy the OEM application file into “Windows->Programs_” folder. 

[Second way is: copy OEM application file into “Windows” folder, creates a 
lnk file of OEM application and copy it into “Windows->Programs_” folder] 

5. Put SD card into the SD socket on B21 device. 
6. Use OEM Device Manager to merge all files in “GHARST” folder in SD 

card into device. After the file integration process, all OEM specify files will 
be the system default components of B21 device. 

 
How to overwrite the factory default settings by using the OEM 
Device Manager 
 

Two config files are used to modify the registry settings of factory default 
mode. System Integrator is easy to add and/or modify the registry key without 
upgraded the image of WindowsCE operating system. The way to remove the 
registry key is to put empty to the key value in the config file. 
System.cfg – Using for early registry initialization stage at booting phase. 
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Oem.cfg – Using for system registry initialization stage at booting phase. 
 

u Example: 
- Overwrite the factory default backlight level setting.   
1. Create a file directory “GHARST” in root folder of SD card. 
2. Change into “GHART” folder to create directory “configfiles”.  
3. Prepare the oem.cfg config file by text editor. 

Input following setting: 
             [HKEY_CURRENT_USER\ControlPanel\BackLight] 
      "BatteryBacklightLevel"=dword:7  
      "ACBacklightLevel"=dword:A 
 

4. Copy oem.cfg file into “configfiles” folder. 
5. Put SD card into the SD socket on B21 device. 
6. Use OEM Device Manager to merge all files in “GHARST” folder in SD 

card into device. After the integration process, all OEM desired settings 
will be the system default settings of B21 device. 

 
- Overwrite the default WiFi state to power on mode. (Default is power 

down)  
1. Create a file directory “GHARST” in root folder of SD card. 
2. Change into “GHART” folder to create directory “configfiles”.  
3. Prepare the system.cfg config file by text editor. 

Input following setting: 
[HKEY_LOCAL_MACHINE\Comm\NdisPower] 

    "GSPI86861"=dword:0  ;0(D0), 1(D1), 2(D2), 3(D3), 4(D4)-Default      
4. Copy system.cfg file into “configfiles” folder. 
5. Put SD card into the SD socket on B21 device. 
6. Use OEM Device Manager to merge all files in “GHARST” folder in SD 

card into device. After the integration process, all OEM desired settings 
will be the system default settings of B21 device. 
 

- Remove a registry key from the registry in factory default settings 
Only have to put the key equal to empty. factory manager will remove the 
specify key from default system registry setting. 
Example:  

[HKEY_LOCAL_MACHINE\RegistryKey] 
    "ValueName"=   
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Overwrite Factory Default Registry Settings for OEM 
Customization (oem.cfg) 

<1> Bluetooth operating mode  
 [HKEY_LOCAL_MACHINE\System\State\Hardware\Bluetooth] 
  “BluetoothOn”=dword:1  ; 1-> BT on, 0->BT off 
  “BluetoothWakeUpEnable”=dword:0     ;1-> Enable, 0-> Disable 
 
<2> WiFi operating mode  
[HKEY_LOCAL_MACHINE\Comm\NdisPower] 
   “GSPI86861”=dword:4  ; 0-> WiFi on, 4->WiFi off 
 
 [HKEY_LOCAL_MACHINE\Comm\GSPI86861\Parms] 
   “PowerMode” = dword:1  ; 0: Performance mode, 1: PS mode 
   “MultipleDTim”=dowrd:2   ; PS mode (0,1,2,3,4 –most power 
saving) 
 
<3> Screen rotation feature  
[HKEY_LOCAL_MACHINE\System\GDI\Rotation] 
   “Angle”=dword:1 ;(Decimal 0->0 degree, 90->90 degree, 180->180 
degree, 270->270 degree)   // Manual rotate mode 
   “AutoRotate”=dword:F    // Auto Rotate control 
    ; bit 15  = 0 (Manual rotate)   = 1 (Auto Rotate) 
    ; bit 0   = 0 (180 degree ignored) = 1 (180 degree accepted)    
    ; bit 1   = 0 (90 degree ignored)  = 1 (90 degree accepted)    
    ; bit 2   = 0 (0 degree ignored)  = 1 (0 degree accepted)    
    ; bit 3   = 0 (270 degree ignored)  = 1 (270 degree accepted)    
 
<4> Backlight control 
[HKEY_CURRENT_USER\ControlPanel\BackLight] 
  "BatteryBacklightLevel"=dword:7   // Backlight level of battery only 
  "ACBacklightLevel"=dword:A   // Backlight level of AC IN mode 
"BatteryTimeout"=dword:3c       // Backlight timeout value of battery only 
mode 
"ACTimeout"=dword:258    // Backlight timeout value of AC IN mode 
  "DimTimeOut"=dword:1E         // Backlight DIM mode timeout  
  "UseBattery"=dword:0      // Battery only mode timeout 
Enable/Disable 
  "UseExt"=dword:0    // AC IN mode timeout Enable/Disable 
    "UseDim"=dword:0    // Backlight DIM mode 
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Enable/Disable 
 
<5> Keypad control 
 [HKEY_LOCAL_MACHINE\Drivers\BuiltIn\KEYPAD] 
   "KeyPadSet0"=dword:27280000 
   "KeyPadSet1"=dword:25260000 
 
<6> CPU operating frequency control 
 Option1: Dynamic Mode 
 [HKEY_LOCAL_MACHINE\Drivers\BuiltIn\IPM] 
   "ProfileType"=dword:0  
  
Option2: Performance Mode 
 [HKEY_LOCAL_MACHINE\Drivers\BuiltIn\IPM] 
   "ProfileType"=dword:1   
"Speed"=dword:0   
 
Option3: Power Saving Mode 
 [HKEY_LOCAL_MACHINE\Drivers\BuiltIn\IPM] 
   "ProfileType"=dword:1   
"Speed"=dword:4   
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Application program of the OEM Device Manager 
  

 
 

 
System Layer : “system.cfg” file update 
OEM Layer : “oem.cfg” file update 
 
Press “OK” button to merge the GHARST directory and specified layer config 
files into OS image   
 

Snapshoot of OEM Device Manager 
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Overwrite display backlight settings 
Once the backlight is enabled, you can set separately both battery backlight 
setting and backlight setting of AC power. System Integrator can use Control 
Panel to change the setting values or modify the following registry keys to 
change settings. Note that the units for the timeout values are in seconds 
 
Registry Key: 
[HKEY_CURRENT_USER\ControlPanel\Backlight] 

 
Modify display backlight settings for AC power 
Values: 

- UseExt    : 1 (Enable/default) / 0 (Disable) 
- ACTimeout   : 15/30/60/120/300/600(default)/900/1800  
- ACBacklightLevel     : 0/1/2/3/4/5/6/7/8/9/10(default) 

 
Modify display backlight settings for battery power 
Values: 

- UseBattery    : 1 (Enable/default) / 0 (Disable) 
- BatteryTimeout   : 15/30/60(default)/120/300  
- BatteryBacklightLevel : 0/1/2/3/4/5/6/7(default)/8/9/10 

 
Modify display backlight settings for DIM mode  
Values: 

- UseDim   : 1 (Enable/default) / 0 (Disable) 
- DimTimeout  : 15/30(default)/60/120/300  

 
Example Code (Update backlight level) 
void UpdateRegistry(DWORD dwVal) 
{ 
 TCHAR szRegClass[] = TEXT("DWORD"); 
 HKEY hRegBacklight; 
 DWORD dwDisposition; 
 if(ERROR_SUCCESS == RegCreateKeyEx(HKEY_CURRENT_USER, 
L"ControlPanel\\Backlight", 0, szRegClass, REG_OPTION_NON_VOLATILE, 
0, NULL, &hRegBacklight, &dwDisposition)) 
 { 
  LONG    lResult; 
  DWORD   dwType = REG_DWORD; 
  DWORD   dwLen = sizeof(DWORD); 
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  // Battery Level 
  lResult = RegSetValueEx(hRegBacklight, L"BatteryBacklightLevel", 
0, dwType, (LPBYTE)&dwVal, dwLen); 
 
  // AC Level 
  lResult = RegSetValueEx(hRegBacklight, L"AcBacklightLevel", 0, 
dwType, (LPBYTE)&dwVal, dwLen); 
 } 
 RegCloseKey(hRegBacklight); 
} 
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4-2-3 Programmable button feature 
Five buttons designed on front bottom of B21 device. Keypad driver will report 
the Windows virtual key code what described in a registry key to system when 
button to be pressed. System Integrator can modify the registry key value of 
each button separately. The modification will work on next button pressed 
instantly. 

 
- One key with combination function: combined Power button and “Enter” 

button functions into one button. 
This button is a fix function button, no available API for function 
modification. 

 
- 4 programmable buttons: defined to be 4 way navigation keys by system 

default mode. All buttons can be re-programmed to one of the number of 
Windows keyboard virtual key code to redefine the button function by 
registry modification. 

 
Registry key definition 

Registry Key: 
[HKEY_LOCAL_MACHINE\Drivers\BuildIn\KEYPAD] 
 

Value Name DWORD (HEX) 

KeyPadSet0 27 (Right) 28(Down) 00 00 

KeyPadSet1 25 (Left) 26 (Up) 00 00 

 
Windows virtual key code 

Virtual key codes 

Symbolic 

constant 
Hexadecimal value Mouse or keyboard equivalent 

VK_LBUTTON  01H  Left mouse button  

VK_RBUTTON  02H  Right mouse button  

VK_CANCEL  03H  Control-break processing  

VK_MBUTTON  04H  
Middle mouse button on a three-button 

mouse  

 05H-07H  Undefined  
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VK_BACK  08H  BACKSPACE key  

VK_TAB  09H  TAB key  

 0AH-0BH  Undefined  

VK_CLEAR  0CH  CLEAR key  

VK_RETURN  0DH  ENTER key  

 0EH-0FH  Undefined  

VK_SHIFT  10H  SHIFT key  

VK_CONTROL  11H  CTRL key  

VK_MENU  12H  ALT key  

VK_PAUSE  13H  PAUSE key  

VK_CAPITAL  14H  CAPS LOCK key  

 15H-19H  Reserved for Kanji systems  

 1AH  Undefined  

VK_ESCAPE  1BH  ESC key  

 1CH-1FH  Reserved for Kanji systems  

VK_SPACE  20H  SPACEBAR  

VK_PRIOR  21H  PAGE UP key  

VK_NEXT  22H  PAGE DOWN key  

VK_END  23H  END key  

VK_HOME  24H  HOME key  

VK_LEFT  25H  LEFT ARROW key  

VK_UP  26H  UP ARROW key  

VK_RIGHT  27H  RIGHT ARROW key  

VK_DOWN  28H  DOWN ARROW key  
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VK_SELECT  29H  SELECT key  

  2AH  
Specific to original equipment 

manufacturer 

VK_EXECUTE  2BH  EXECUTE key  

VK_SNAPSHOT  2CH  PRINT SCREEN key  

VK_INSERT  2DH  INS key  

VK_DELETE  2EH  DEL key  

VK_HELP  2FH  HELP key  

  3AH-40H  Undefined  

VK_LWIN  5BH  
Left Windows key on a Microsoft Natural 

Keyboard  

VK_RWIN  5CH  
Right Windows key on a Microsoft 

Natural Keyboard  

VK_APPS  5DH  
Applications key on a Microsoft Natural 

Keyboard  

  5EH-5FH  Undefined  

VK_NUMPAD0  60H  Numeric keypad 0 key  

VK_NUMPAD1  61H  Numeric keypad 1 key  

VK_NUMPAD2  62H  Numeric keypad 2 key  

VK_NUMPAD3  63H  Numeric keypad 3 key  

VK_NUMPAD4  64H  Numeric keypad 4 key  

VK_NUMPAD5  65H  Numeric keypad 5 key  

VK_NUMPAD6  66H  Numeric keypad 6 key  

VK_NUMPAD7  67H  Numeric keypad 7 key  

VK_NUMPAD8  68H  Numeric keypad 8 key  

VK_NUMPAD9  69H  Numeric keypad 9 key  
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VK_MULTIPLY  6AH  Multiply key  

VK_ADD  6BH  Add key  

VK_SEPARATOR  6CH  Separator key  

VK_SUBTRACT  6DH  Subtract key  

VK_DECIMAL  6EH  Decimal key  

VK_DIVIDE  6FH  Divide key  

VK_F1  70H  F1 key  

VK_F2  71H  F2 key  

VK_F3  72H  F3 key  

VK_F4  73H  F4 key  

VK_F5  74H  F5 key  

VK_F6  75H  F6 key  

VK_F7  76H  F7 key  

VK_F8  77H  F8 key  

VK_F9  78H  F9 key  

VK_F10  79H  F10 key  

VK_F11  7AH  F11 key  

VK_F12  7BH  F12 key  

VK_F13  7CH  F13 key  

VK_F14  7DH  F14 key  

VK_F15  7EH  F15 key  

VK_F16  7FH F16 key  

VK_F17  80H  F17 key  

VK_F18  81H  F18 key  
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VK_F19  82H  F19 key  

VK_F20  83H  F20 key  

VK_F21  84H  F21 key  

VK_F22  85H  
F22 key  

(PPC only) Key used to lock device. 

VK_F23  86H  F23 key  

VK_F24  87H  F24 key  

  88H-8FH  Unassigned  

VK_NUMLOCK  90H  NUM LOCK key  

VK_SCROLL  91H  SCROLL LOCK key  

VK_LSHIFT A0H Left SHIFT 

VK_RSHIFT A1H Right SHIFT 

VK_LCONTROL A2H Left CTRL  

VK_RCONTROL A3H Right CTRL 

VK_LMENU A4H Left ALT 

VK_RMENU A5H Right ALT 

  BA-C0  

Specific to original equipment 

manufacturer; reserved. See following 

tables. 

  C1-DA  Unassigned  

  DB-E2  

Specific to original equipment 

manufacturer; reserved. See following 

tables. 

  E3 – E4 
Specific to original equipment 

manufacturer 

  E5  Unassigned  

  E6  Specific to original equipment 
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manufacturer 

VK_PACKET E7 

Used to pass Unicode characters as if 

they were keystrokes. If VK_PACKET is 

used with SendInput, then the Unicode 

character to be delivered should be 

placed into the lower 16 bits of the scan 

code. If a keyboard message is removed 

from the message queue and the virtual 

key is VK_PACKET, then the Unicode 

character will be the upper 16 bits of the 

lparam. 

  E8  Unassigned  

  E9-F5  
Specific to original equipment 

manufacturer 

VK_ATTN  F6  ATTN key  

VK_CRSEL  F7  CRSEL key  

VK_EXSEL  F8  EXSEL key  

VK_EREOF  F9  Erase EOF key  

VK_PLAY  FA  PLAY key  

VK_ZOOM  FB  ZOOM key  

VK_NONAME  FC  Reserved for future use  

VK_PA1  FD  PA1 key  

VK_OEM_CLEAR  FE  CLEAR key  

VK_KEYLOCK F22 Key used to lock device 
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Example code 
 
void ModifyKeyCode(DWORD data)  
{    //modify the virtual key code of up button  
HKEY   hKeyPad = NULL; 
TCHAR  RegStr[14], 
  if (ERROR_SUCCESS == RegOpenKeyEx(HKEY_LOCAL_MACHINE, 
L"Drivers\\BuiltIn\\KEYPAD", 0, 0, &hKeyPad)) 
  { 
wsprintf(RegStr,L"KeyPadSet0");    //assign value name of up button  
dwSize = sizeof(DWORD); 
if (ERROR_SUCCESS == RegQueryValueEx(hKeyPad, RegStr, NULL, 
&dwType, (LPBYTE)& SaveReg, &dwSize)) 
{ 
 
data = (data << 24) & 0xff000000;    
SaveReg = (SaveReg &0x00ffffff) | data;   // modify the virtual key code of 
up button 
RegSetValueEx(hKeyPad, RegStr, NULL, dwType, (LPBYTE)&SaveReg, 
dwSize); 
} 
  } 
  RegCloseKey(hKeyPad); 
} 
 
 



 

 69 

4-2-4 Vibration notification feature 
A vibrator is designed into this device for notification usage. The vibrator 
driver is following the notification LED driver architecture of WindowCE to be 
developed. This architecture is easy for System Integrator using WindowCE 
NLED standard API for application development, and also provides the 
advantage of backward compatibility. 
 

Data Structure introduction 
 

struct NLED_SETTINGS_INFO 
    { 
    UINT    LedNum;      
    INT     OffOnBlink;    
    LONG    TotalCycleTime;  
    LONG    OnTime;         
    LONG    OffTime;        
    INT     MetaCycleOn;     
    INT     MetaCycleOff;     
    }; 
LedNum  

LED number. Virbrator is zero (0).  
OffOnBlink  

Current setting. The following table shows the defined values.  

Value  Description  

0 Off 

1 On 

2 Blink 

TotalCycleTime  
Total cycle time of a blink, in microseconds. (Not support – default 0) 

OnTime  
On time of the cycle, in microseconds. (Not support – default 0) 

OffTime  
Off time of the cycle, in microseconds. (Not support – default 0) 

MetaCycleOn  
Number of on blink cycles. (Not support – default 0) 
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MetaCycleOff  
Number of off blink cycles. (Not support – default 0) 

 

Example code 
 
#include "stdafx.h" 
 
NLED_SETTINGS_INFO ledSettingsInfo   = { 0 }; 
 
void SetVibratorOn(void) 
{ 
 ledSettingsInfo.LedNum = 0; 
 ledSettingsInfo.OffOnBlink = 0; 
 if(!NLedSetDevice(NLED_SETTINGS_INFO_ID,&ledSettingsInfo)) 
      MessageBox(L"NLED ghNLED = NULL!!",L"Error",MB_OK); 
    } 
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5   Optional Accessory Installation 
5-1 USB Cable 

There is only USB port with WindowsCE® ActiveSync® function to be 
exposed to software developer to develop and debug their software 
application. 
A specific application program located in “Application” Folder and named 
as “USB.EXE” to provide manual USB Activesync connection. 
A specific USB cable would be required. 

 
USB Cable Snapshot 

 

 
Optional USB Cable is for functioning Synchronization with PC and 
Software uploading or Debug. 

 

To PC 

To Mobile 
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5-1-1 Synchronization via USB Cable 
To synchronize the Mobile System with PC, please install the “Microsoft 
Active Sync” program on each PC first. 
 
The set-up of a “Partnership” will be requested once after connecting the 
USB Cable to the Mobile System and PC. 

 
 

The Synchronization will be running automatically after “Microsoft Active 
Sync” and “Partnership Set-up” being installed successfully and the USB 
Cable is connected.  
Please refer the detail installation procedure of ActiveSync program to the 
Microsoft official website. 
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5-1-2 Installing the USB Cable 

 
1. Unscrew the screws (2) on the back cover of the Mobile System to 

access the Connector Slot. 

 

 
2. Connect the white connector to the Mobile System. 

 

 

3. Connect the USB Connector to the PC device to communicate the 
Mobile System and the PC. 

 

To Mobile 

To PC 

PC 
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5-1-3 Start the Synchronization 
After installing the “Microsoft® ActiveSync®” program at your PC, please 
enable it. You will see the “Connecting” is running automatically after USB 
Cable is connected the Mobile System and PC.  
 

Ø NOTE: If the “Connecting” is not running automatically, 
please go to the Chapter 5.3.3 to connect manually 

 

 
1. The “Microsoft ActiveSync” window will show “Connected” after 

USB Cable is successfully connected. 

 
Ø Note: To choose “Options” tab to set up the customized 

Synchronization items on your own. 
 
 

 

2. Double click the “Mobile Device” icon by opening “My Computer” to 
access the documents or files saved in the Mobile System. 



 

 75 

5-1-4 Enable the Synchronization Manually 
If the synchronization is not running automatically after connecting the USB 
Cable to your PC and the Mobile System, please follow below steps. 
 

   

1. Double-click on the “My Device” icon on Today screen. 

 

    
 

2. Double-click on the “Application Data” folder.  

3. Double-click on the “usb” icon. 
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4. Select “USB” tab 

5. Press “Connect” button. 

6. Select “ActiveSync” tab. 

7. Select “ACTIVE SYNC” button. 

8. Press “OK” button. 
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5-2 MSR Module Installation 
 

 

1. Unscrew the screws (2) on the rear side of the Mobile System. 

2. Slide upward to open the Connector Cover to access the connector 
slot. 

 

 

3. Connect MSR cable to the respective connector on the connector 
slot of the Mobile System. 
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4. To make sure the metal juts are entered to the right position of the 
system. 

 
 
 
 

    
5. Use the attached screws (2) to fix the MSR module to the Mobile 

system as above photo shows. 
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6. Finished.  

Front view of the MSR module and the Mobile system. 
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5-3 2-in-1 MSR and Scanner Module 
Installation 

 

 

1. To open the connector cover on the Mobile System first by 
following the steps in Chapter 5.2.1 

2. Connect cables (2) to the respective connectors on the connector 
slot of the Mobile System. 

 

 

3. To make sure the metal juts are entered into the right position of the 
Mobile System. 

 

 

 

 

 

Scanner Cable 

MSR Cable 
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4. To use the attached screws (2) to fix the 2-in-1 MSR module to the 
Mobile System. 

 

 

5. Finished.  
The front view of the 2-in-1 MSR and Scanner Module with the 
Mobile System. 


